
Course Program
LO = Learning Objective

Monday March 11
Sharing
 

Session 1: Introduction and Overview 
Welcome

Introductions

Purpose

Logistics

Course Overview

Setup

Discussion Questions

Software to be installed

 

Session 2a: Language Software Overview
LO:
1.    Participants will know which software to use for what language development task. 
2.    Participants will know to what updates are available in language software.
3.    Participants will know what others are using in their country for language development work. 

Connection: 
Ask participants to list 4 major softwares used language development work?
What versions (stable release) of these software exist right now? 

Content:
Present a PowerPoint with an overview of language development software. 

Challenge:
Have the learners fill in the survey of what is used in their context. 

Changes: 
Identify some ways you can be a language technology promoter in your area? 

Closure:
Write down in your notebook what is important to you and what you intend to do when you return

http://lingtran.net/dl1337


back to your work. Do you want to share it with the team?
 

Session 2b: Growth Plan
LO:  To begin or update a growth plan for each participant

Growth Plan presentation

 

Session 3: How to use Lantran.net
LO: The participants will be able to add and update content on the wiki site, inserting images as
needed.

Creating Pages

Adding Images

 

Session 4: Language Forge
LO:  The participants will know how to build an online Lexicon using language forge.

Language Forge presentation

 

Tuesday March 12
Sharing
 

Session 1: Paratext 9 - UI
LO: The participants will learn to use and teach the new windowing system in Paratext 9. They will
be able to explain the advantages of the new system for translators.

Paratext 9 User Interface

 

Session 2a: Paratext 9 - Project Plan
LO: The participants will add a base plan to a project and customise the plan as needed.

Anchor: Why do I need to I do this?
Our goal is to help teams plan for success. What has been your experience of the project plan in
your branch? Discuss ideas of 
-    Need to plan to succeed. 
-    Laying a firm foundation
-    Firm but customized to fit 

http://lingtran.net/dl1305
https://lingtran.net/Creating+Pages
https://lingtran.net/Adding+Images
http://lingtran.net/dl1338
https://lingtran.net/Paratext+9


-    What problems with plan?
-    Too complicated/tedious
-    Have to do whole book – new feature in 9 overcomes that, it is also being back-ported to PT8   
-    Let’s have a look
Note: Administrator’s only
    
Add: What do I need to know?
Demo
•    Copy the LTCT base plan to the _standardplans folder
•    Set scope
•    Copy the plan – see new setting
•    Participants send/receive, admin copy the plan, send/receive by USB to partner
•    Change Role to Observer
•    Tweak the plan (delete, add, move tasks)
•    Configure task settings  (note new feature means 
•    Assign checks to stages
•    Assign tasks to team members

Apply: How does this work?
Participants continue to work in pairs customising it as necessary (following the guide). They will
assign tasks as desired. 

Summary
Complete the summary in the PowerPoint

Away : What can this become?
Reflect on what is happening in your branch. 
How can you find out if your branch has a customized base plan?
Who is using the plan well?
Who is not using the plan? What can you suggest
    

Session 2b: Planning and Teaching a Workshop
LO:
1. The participants will know to plan a LT workshop
2. The participants will plan one LT workshop  using the workshop planning form

Connection:
First have each participant from LTCT2018 will share their experience from the workshop
that they planned at LTCT2018 using Workshop Report Form.

Content:
Present a PowerPoint and discuss with the participants as they have lots of ideas running workshops.

Challenge
Explain the workshop planning forms.
Have each participant plan a workshop for the coming year using the workshop form.

http://lingtran.net/dl1339
http://lingtran.net/dl1340


Changes:
Have each participant have their filled-out form checked by an instructor.

Closure:
What will you take away from this session?

 

Session 3a: LSDev Report
What is happening in LSDev presentation

 

Session 3b:  WSTech Report
Accessing Language Resources presentation

 

Session 4: Regular Expressions (session 1 of 2)
LO:
1. The participants will be familiar with the syntax of regular expressions.
2. The participants will be able to write simple regular expressions.
3. The participants will be to modify a text file usinf regular expressions

Connection:
Discuss the reasons for using regular expressions.

To convert a text documents into a SFM file.1.

To make global changes to a text file2.

Content:
The instructor will present the basic comands of regular expressions:  Slides 1- 7

Challenge

The instructor will have the participants work together to do ten exercises.  Slides 8-17

Change

The students will work on some exercise on their own (Regular Expression Exercises.docx)

 

Wednesday March 13
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http://lingtran.net/dl1343
http://lingtran.net/dl1344
http://lingtran.net/dl1341
http://lingtran.net/dl1341
http://lingtran.net/dl1342


Session  1: Paratext 8 -FLEx Integration
LO:
1.    The participants will know to setup ParaTExt – FLEx integration
2.    The participants will make FLEx and ParaTExt to collaborate together.

Paratext-FLEx Integration tutorial

Connection:
Explain what FLEx – ParaTExt collaboration or integration is all about.

Content:
Present this using material from the ParaTExt – FLEx intergration tutorial and the Paratext 8-FLEx
Integration presentation.

Challenge
Have participants setup a FLEx project and a ParaTExt project for collaboration. 

Changes:
Have each participant use the collaboration feature in ParaTExt to update material in FLEx and vice
versa. 

Closure:
What will you take away from this session? 
 

Session 2: Scripture App Builder
LO: The participants will  upgrade to the latest version (5.1), including a necessary SDK upgrade.
They will create apps using the new features (e.g. videos/slideshows and keyboards).

create apps which include videos clips
build an app for several chapters only
embed a keyboard into an app

Learning Task 1 - Create a simple app1. Build a simple app to review the process in this new
version. 

Create an app for the gospel of Luke from your Paratext project LT19 (or other suitable project)
Compile the app
Install the app on your device.

Learning Task 2  - Create an app with video clips from Jesus Film.  

Click Video in the list (at left), then Video tab
Add video button
Choose Jesus clips
Confirm that the placement is correct
Build the app and check it on your device

Learning Task 3  -Build an app with a Keyman keyboard embedded (undocumented)

Edit an existing app.

https://lingtran.net/ParaTExt-FLEx+Integration+Tutorial
http://lingtran.net/dl1345
http://lingtran.net/dl1345


To add a Keyman keyboard.
Browse to locate the js file
Note a KMP package is zip file, unzip to find the js.
Fill in all the parameters, OK
Select a keyboard to use
Book collection (in list) > Styles (tab).
Enter the language code
Choose the Keyboard
Build and test the app.

Learning Task 4 - Build an app with a portion

Build an app for the Christmas Story.
You will want to set the book tab of the book to portions and specify the chapter/verse range.

Summary - Now that you have completed the tasks, confirm that you can

To create an app with video clips you use the  wizard from the ___ list.
There are _ steps to embed a Keyman keyboard. First you need to add the _file. You do this
under the _ in the list. This js file is found in the Keyman file. Then you specify which
keyboard in tab of the book __ list.
To create an app with portions of scripture you access the _ tab of the actual book in the
collection.

 

Session 3: Bloom (session 1 of 2)
LO:

The participants will know how to create a basic book using Bloom.
The participants will know how to publish a basic book using Bloom.
The participants will know how to create a shell book using Bloom.
The participants will know how to create a Bloom pack.

Learning Tasks (How):

Connection:
Review the objectives of this session.
Engage with participants about the use of Bloom from the previous LTCT.

Content:
How to create a Bloom collection
How to create simple books using the Basic Book template
How to publish a book to PDF
How to create a shell book using a customized Bloom template
How to create a Bloom pack

Challenge:
This is to be done alongside the participants.



The participants will create a vernacular collection
The participants will create a basic book
The participants will create a source collection
The participants will be able to create a shell book by customizing the basic book template
The participants will be able to create a Bloom Pack.

Changes:
The participants will demonstrate the skills learned by

Creating a vernacular collection using a different story
Create a simple book using the basic template
Save the book as PDF
Creating a source collection
Add a shell book  using a customized basic book template
Create a Bloom pack

Session 4: Problem Solving
The participants discussed  actual difficulties and problems that they have faced in the past year.
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Session 1:  Paratext 9 - Using the Project Plan
LO: The participants will use the project plan to assign and monitor tasks. The will produce a
progress chart.

Use the project plan to identify tasks which have been assigned to you.
Mark individual tasks as completed for a variety of types of tasks (by project, book or chapter).
Mark several chapters as complete through several stages
Bulk update the progress of an ongoing project, (i.e. mark complete stages as finished).

Anchor: Why do I need to I do this?
Our goal in setting up the plan was so that the project can succeed.
Now we need to work the plan, checking tasks, updating completed tasks. Show charts of progress. 

Add: What do I need to know?
Investigate: If you had to do this on your own, where would you look to find out how to do it?
    
Demo (if needed)

Access the project plan (float the window!)
View my tasks, mark tasks as complete
View all tasks
Postpone tasks
View stages table, mark tasks as complete



View forecast graph

Apply: How does this work?
Participants to work through the learning tasks in the Powerpoint 

They should update the progress as required  
Postpone as necessary
Produce a forecast line chart. Play with the start and end dates.

Summary
Complete the summary in the PowerPoint
 

Session 2: PrimerPro
LO:
1. The participants will have a basic understanding on how to use PrimerPro.
2. The participants will know how to use PrimerPro to produce a recommended teaching
order
3. The participants will know how to use PrimerPro to create a primer lesson.

Connection:
Present the PrimerPro Overview powerpoint.

Content:
The instructor will demonstrate the steps of Primerpro for determining the recommended teaching
order
•    Create a project.
•    Setup options.
•    Initialize grapheme inventory using text data
•    Completing the grapheme inventory
•    Verify grapheme inventory
•    Import wordlist and text
•    Generate teaching order

The instructor will demonstrate the steps of PrimerPro for making a primer lesson using Easy Steps
for Making Lessons in PrimerPro.
 
Challenge
The participants will produce their second consonant primer lesson using Easy Steps for Making
Lessons in PrimerPro, as their guide.

Change
The participants will produce their first review lesson, using the document, Easy Steps for Making
Review Lesson in PrimerPro.pdf, as their guide.
 

http://lingtran.net/dl1350
http://lingtran.net/dl1346
https://lingtran.net/PrimerPro+Easy+Steps
https://lingtran.net/PrimerPro+Easy+Steps
https://lingtran.net/PrimerPro+Easy+Steps
https://lingtran.net/PrimerPro+Easy+Steps


Session 3: Paratext 8 - Advanced Topics
Paratext Registration

 

Session 4: ALTC Meeting
Participants listened to the Area Language Technology Coordinators (ALTC) zoom Meeting

Friday, March 15
Sharing
 

Session 1: Paratext 9 - Enhanced Resources
LO: The participants will use an Enhanced resource to better understand the source text. They will

download/install an enhanced resource and images
access definition, encyclopedic and other information on senses of a Greek word
search for other occurrences of verses using a Greek word
add/modify renderings for terms in a passage

Learning Task 1 – Download/install enhanced resource(s)
1.    Copy files from USB – Paratext Enhanced Resources
2.    From the main menu, choose Download/Install resources
3.    Choose folder, browse for your folder
4.    In the filter text box, type Enh
5.    Select the desired resources and images and maps.
6.    Click Download/Install

Learning Task 2 – Open and arrange windows
1.    Open a text collection window with several standard resources
2.    Open your LT19 project
3.    Open the Biblical terms renderings window for your project
4.    Open an enhanced resource
5.    Arrange your screen as desired
6.    Save your current layout

Learning Task 3 Access information on a research term in an enhanced resource
1.    Go to the passage you want to study (e.g. Mat 5:3)
2.    Click All research terms button 
3.    Click on a highlighted research term (e.g. blessed)
4.    The underlying Greek term and definition are displayed.
5.    Add a rendering of happy for blessed by clicking on the orange “Add a rendering” link. 

Learning Task 4 Access other verses with that term
1.    After the definition of the Greek word, there is a link showing the number of other verses with
that term e.g. (50)
2.    Try some other terms as well.

https://pt8.paratext.org/registration/


Learning Task 5 Access additional information
There is additional information on many but not all terms. Experiment with various terms. For
example:
1.    Look at images: figs Mat 7:15, zoom in on images, 
2.    Look at maps: Acts 21:4, zoom in (left click) or out (right click) on map
3.    Look at encyclopedic information: cock Mat 26:34

Summary
Now that you have completed the tasks,
Enhanced resources and images are installed __ (together or separately?)
To see the underlying Greek word, you click on___
What are the four icons? __ 
To see other verses with the same Greek word click on __
Click a rendering to add terms used in your project.
To highlight problems with rendering in Biblical terms click on _  turns ___. 

 

Session 2: Paratext Lite
Paratext Lite presentation

 

Session 3a: Bloom (session 2 of 2)
This is a continuation from session 3 above.

Lo:
The participants will understand the enterprise features and how to use them.
The participants will know how to adapt books from the Bloom library.
The participants will know how to upload books to the Bloom library.
The participants will know how to create talking books

Content

How to use the Bloom library to adapt and share books
How to create the talking book
How to use the enterprise features to insert logos

Challenge

The participants will learn how to search the Bloom online library
The participants will learn how to adapt and upload books
The participants will create an audiobook from the basic book created
The participants will use enterprise features to customize their shell books

Change

Identify books from the Bloom library to adapt and also share books to the Bloom online library

http://lingtran.net/dl1355


Create a talking book
Use and promote enterprise features

 

Session 3b: Bloom Reader
LO:
1.    The participant will move Bloom book to the Bloom Reader.
2.    The participant will play a Bloom book in the Bloom reader in Android.
3.    The participant will reformat a Bloom book to fit properly in Bloom Reader.
 

Connection:
Why Bloom? 

Content:
Do the following with the participants.
1.    Install Bloom Reader on an Android device. 
2.    Install English Talking Books.bloomPack
3.    Publish Agama Lizard, a Bloom talking book, to Bloom Reader, noting that you need to change
device to 16x9Portrait
4.    Open Agama Lizard in Bloom Reader
5.    Navigate through the book, noting any problems.
6.    Demo how to add a quiz page and a motion page.

Challenge:
1.    Edit Agama Lizard to reformat Bloom Reader to get it fit better in Bloom Reader
2.    Publish it again to your Android device
3.    Open the book in Bloom Reader, verifying the problems are gone.
4.    Repeat steps 6 through 8 as necessary.
5.    Find Bloom books on this device

Changes:
Have the students do the following on their own.
1.    Publish another Bloom book to the Bloom Reader.
2.    Open the book in Bloom Reader and navigate through it.
3.    If necessary, reformat the bloom book and publish it again to Android.
 

Session 4 : Problem Solving
The participants discussed  actual difficulties and problems that they have faced in the past year.

 

Monday March 18
Sharing
 



Session 1a: General Discussion
Copy of  LangTran folder available on USB drive

Virtual Paradox 9 trainer orientation

May 21-23 starting at 15:00 GMY for 3 hours

Day 1: New UI

Day 2: Enhanced resources

Day 3: Improved project plan

Are there any languages in our region that should be localized?  (e.g.  Hausa and Swahili)

Steve White’s video Logos Finding resources

Software.sil.org

 

Session 1b: Paratext 8 - Spell Check
LO:
1. use display spelling to make spelling choices while draftin
2. use the spell checking tool to make global changes to words that Paratext thinks are incorrect.
3. use the find similar words tool to make global changes to words that differ by very few things (1 letter or 1 4.
diacritic difference, or several letters)
5. use the find incorrectly joined or split tool to make global changes to words that are exactly the same except
for 6. how they are joined or separated
7. use the spelling notes to aid in spelling choices

Learning Task 1 –  Use Spell checking in the editing window
(See Paratext Manual, Chapter 9 Spell Checking 9.2 Spell checking from the text & 9.3 Making
corrections).  This tool helps you make corrections inside the text without having to leave your
drafting, team or consultant checking session.

Learning Task 2 –  Use Spell Check/All Checks 
(See Paratext Manual, Chapter 9 Spell Checking 9.1.2 Check the words that Paratext thinks are
incorrect;  Also see 9.5.3-9.5.8 ).  This check reviews spelling, hyphenation and morphology of the
words in your text.

Learning Task 3 – Use Similar Words Check
(See Paratext Manual, Chapter 9 Spell Checking 9.1.3 Check similarly spelled words).  This check
isolates words that are spelled very similarly, but differ by a letter, a diacritic or just a few
differences.

Learning Task 4 – Use Incorrectly joined or split words Check
(See Paratext Manual, Chapter 9 Spell Checking 9.5.9 Find incorrectly joined or split words p. 48).
This check helps you find words which may have become incorrectly joined together, split by
punctuation or separated by a space.

Learning Task 5 – Use Spelling Notes

https://vimeo.com/321990370
https://software.sil.org


This notes tool helps consultants and team members to make comments and suggestions in
spelling. 

Learning Task 6 –  Some Do’s and Don’ts when checking for spelling

 

Session 2a: < strike="">Paratext 8 - Back Translation &
Interlinearizer
LO: 
1.    The participants will know how to create back translation project
2.    The participants will know how to draft a back translation
3.    The participants will know how to generate an interlinear

Learning Tasks (How):
1.    How to create a back translation project
2.    How to type in a back translation text manually into the BT project comparable to the main
translation project.
3.    How to determine the meaning of status boxes in a BT project.
4.    How to make a) Word-for-word BT, b) Phrase by phrase BT 
5.    How to create a back translation using interlinearizer
6.    How to create an interlinear project for back-translation
7.    How to go about adding glosses and approving them in an interlinearizer
8.    How to send approved verse texts from interlinearizer to destination BT project

Back Translation presentation

Interlinear presentation

 

Session 2b:   < strike="">Paratext 8 - Project History/Compare
Texts
LO: 
1. The participants will know how to mark a point in the project history
2. The participants will know how to use the filtering system in project history
3. The participants will know how to compare two versions

Connection
Discuss learning objectives
Explain what project history is and why it is important.
Explain when to mark a point in the project history.

Content 1
1. Show the participants how to mark a point in the project history.
From your project window:
a. Find and replace the word “Creation” by “The Story of Creation” and “ground” by “land”.
b. Go to Genesis Chapter 2 and change “The Creation of Man and Woman” to “The Garden of Eden”
c. Go to Project menu and Mark Point in Project History…

http://lingtran.net/dl1354
http://lingtran.net/dl1353


d. Type in the comment box “###Musie:changed words” and click Ok.
e. Go to Project menu and Project History and find your point with the comment.
f. Do Send/Receive

Challenge 1
The participants will do the following from their project window:
a. Find and replace the word “God” by “Yahweh” and delete Genesis Chapter 4 verse 4.
b. Go to Genesis Chapter 8 and change “The Flood Subsides” to “The Water Goes Down”
c. Go to Project menu and Mark Point in Project History…
d. Type in the comment box “###YourName:changed words” and click Ok.
e. Go to Project menu and Project History and find your point with the comment.
f. Do Send/Receive

Content 2
Show the participants how to use the filtering system in project history.   Go to Project ==>Project
History
Work around the Project History window to show filtering features.

Challenge 2
The participants will do the following from their project window.  Go to Project ==>Project
History Work around the Project History window to see filtering features.

Content 3
Show the participants how to compare two version. From your project window:
a. Go to Tools==>Compare Texts (CRL+SHIFT+C)
b. In the “Compare Text” window, select the current version in either pane. By default it appears on
the left pane.
c. From the drop-down list above the pane which does not contain the “Current Version”, select the
earlier version of the project that you worked on Content 1.
The default color and formatting for added (newer) text is green and that of removed (older) text is
red. 

Challenge 3
The participants will do the following from their project window:
a. Go to Tools==>Compare Texts (CRL+SHIFT+C)
b. In the “Compare Text” window, select the current version in either pane. By default it appears on
the left pane.
c. From the drop-down list above the pane which does not contain the “Current Version”, select the
earlier version of the project that you worked on Content 1.

Summary 
Review what they have learned.
 

Session 3: Keyman (Session 1 of 2)
How to modify a Keyman keyboard

 

https://lingtran.net/How+to+Modify+a+Keyman+Keyboard


Session 4: Adapt It
Adapt It presentation (first session of two)

 

Tuesday March 19
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Session 1: Reading App Builder
LO:
1.      The participants will know how to build a reading app from a Bloom book.
2.      The participants will know how to build a reading app from a Word document.

Connection: Install necessary programs.
1.    Install and setup RAB
a.    Install Reading App Builder 
b.    Install Java SE Development Kit (JDK)
c.    Install Android Software Development Kit (SDK)
d.    ePub reader or Gitden reader.

Content: 
Reading App Builder presentation

Challenge:
Each is required to create two apps, one out of a word document, and one from a bloom book.

Changes: 
They are to build a reading app from word and bloom
 

Session 2a: Dictionary App Builder
LO: By the end of these sessions, you will
1. know what DAB is
2. know why DAB exists
3. be able to create a Dictionary App from FLEx 
4. be able to create a Dictionary App from WeSay 

Learning Task 1 : Create a Dictionary App from FLEx
1.    Create FLEx project and export LIFT file
a.    Open FLEx
b.    Open FLEx project : File > Project Management > Restore a Project…
c.    Browse for \Course\Dictionary App Builder\FLEX\Simple-02 2019-03-18 1948.fwbackup
d.    Export file using File > Export > Full Lexicon LIFT 0.13 XML to Desktop
2.    Build Dictionary App
a.    Start Dictionary App Builder
b.    Click New App…

http://lingtran.net/dl1349
http://lingtran.net/dl1352


c.    Browse for the LIFT file on your Desktop
d.    Go through the New App dialog steps
e.    About information : ALT+0169 => ©
f.    Make sure Tools > Settings > After Build options are checked (Install + Run) 
g.    Click Build Android App
h.    Check result

Learning Task 2 : Create a Dictionary App from WeSay
1.    Create WeSay dictionary project

Use the Windows File Explorer to copy the Kasem project directory from \Course\Dictionary App
Builder\WeSay_Kasem_project to \Documents\WeSay
Double click on the Kasem.WeSayConfig file to open the project in WeSay Configuration Tool
Click Open in WeSay in the top right corner

2.    Build Dictionary App

Start Dictionary App Builder
Click New App…
Browse for the WeSay project created in step 1 : \Documents\WeSay\WeSay_Kasem_project and
select Kasem.LIFT
Go through the New App dialog steps
Make sure Tools > Settings > After Build options are checked (Install + Run) 
Click Build Android App
Check result

3.    Update WeSay dictionary and Rebuild Dictionary App to include audio

Open the Kasem project in WeSay
Click on Dictionary Browse & Edit
Select a word (e.g. bira = wall)
Add a recording (second line in Word field)
Repeat steps c-d for 4 more words
Open the Dictionary App Builder
Open Kasem Dictionary > Audio
Click Add Audio Files…
Select \Documents\WeSay\Kasem\audio\ and select the audio files for words created in steps c-e
Make sure Tools > Settings > After Build options are checked (Install + Run) 
Build Android App
Check result (including audio)

4.    Update WeSay dictionary and Rebuild Dictionary App to include pictures

Open the Kasem project in WeSay
Click on Dictionary Browse & Edit
Select a word (e.g. bira = wall)
Click Show Uncommon Fields
Click Get Picture…
Add a picture
Repeat steps c-d for 4 more words



Open the Dictionary App Builder
Open Kasem Dictionary > Images > Illustrations
Click Add Image…
Select \Documents\WeSay\Kasem\pictures\ and select the picture files for words created in
steps c-e
Make sure Tools > Settings > After Build options are checked (Install + Run) 
Build Android App
Check result (including pictures)

 

Session 2b: Regular Expressions (session 2 of 2)
see  Tuesday March 12, session 4

 

Session 3: Keyman (Session 2 of 2)
How to modify a Keyman keyboard

 

Session 4: Scripture Forge
Scripture Forge presentation

Wednesday March 20
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Session1: Snapshots
Render1.
Transcriber2.
SIL Language Software Community (web site)3.
How to manage too many notes in Paratext?4.
FLEx 95.
WeSay 1.66.

 

Session 2a: Adapt It
Adapt It presentation (second session of two)

 

Session 2b: HearThis
LO:
1. The particpants willl record some scripture using HearThis

https://lingtran.net/How+to+Modify+a+Keyman+Keyboard
http://lingtran.net/dl1351
http://lingtran.net/dl1349


2. The particpants will record some scripture using HearThis Android
3. The particpsntd will sync HearThis Android  with HearThis

Connection:
Three books were done with multiple readers who will take the various character parts (Luke, Acts,
Revelation). We had 3-4 people recording at one time, and two people checking recorded material.
During the first few weeks, we worked for approximately 20 days and recorded about 4000 verses;
so that averages about 200 verses/day for first draft. I estimate there may be about four weeks of
revision and editing left. So I project that the total time for publishable recording will be about 10
weeks for the NT. So two to three months for a basically edited text. That sure beats 14 months!
What is your experience using HearThis?

Content:
1.    Show the HearThis presentation.
2.    Demo recording scripture using HearThis - open project, record, check, next,  skip, font size
& two parts.

Challenge:
1.    The participants will create a new HearThis project.
2.    The participants will record and play a portion of scripture
3.    The participants will install and start HearThis Android.
4.    The participants will sync the HearThis project with HearThis Android
5.    The participants will record more Scripture using HearThis Android.
6.    The participants will sync again and play recording
 

Session 3: SayMore
LO: The participants will

Create a new SayMore project
Add a person to a project
Add audio file
Transcribe an audio file
Archive data to REAP
Export transcription to FLEx

SayMore Presentation

 

Session 4: Evaluation and Debrief
 

http://lingtran.net/dl1348
http://lingtran.net/dl1347
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